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1. Что такое Blender 3D 

Blender 3D — это бесплатная программа для создания трёхмерной графики и анимации. В 

ней можно создавать 3D-объекты, текстуры, анимированных персонажей. Blender 3D 

используют в проектировании, веб-дизайне, 3D-анимации, кино, видеоиграх и т. д. 

Например, капитан «Летучего голландца» Дейви Джонс из фильма «Пираты Карибского 

моря» смоделирован в Blender 3D. 

 

Эта программа включает в себя:  

1. Рендеринг –  

этап создания 3D-графики, при котором программа преобразует трехмерную сцену 

(модели, свет, материалы) в двумерное изображение или видеофайл. Процесс 

включает просчет освещения, теней, отражений и текстур для достижения 

реалистичного вида. В Blender используются 

движки Cycles (фотореализм), Eevee (реальное время) 

и Workbench (предпросмотр). 

Создать потрясающие визуализации можно с помощью Cycles — мощного трассировщика 

лучей для ультрареалистичного рендеринга. 

 

https://practicum.yandex.ru/blog/chto-takoe-dizajn-sajta-i-dlya-chego-nuzhen/
https://www.google.com/search?q=Cycles&oq=%D1%80%D0%B5%D0%BD%D0%B4%D0%B5%D1%80%D0%B8%D0%BD%D0%B3+%D0%B2+%D1%8C%D0%BB%D0%B5%D0%BD%D0%B4%D0%B5%D1%80+%D1%8D%D1%82%D0%BE&gs_lcrp=EgZjaHJvbWUyBggAEEUYOTIJCAEQABgNGIAEMgoIAhAAGIAEGKIEMgoIAxAAGIAEGKIE0gEJNzUzM2owajE1qAIIsAIB8QU3ak5NDMGz2PEFN2pOTQzBs9g&sourceid=chrome&ie=UTF-8&ved=2ahUKEwj01PuP8OyTAxUkKRAIHaIDAawQgK4QegYIAQgAEAM
https://www.google.com/search?q=Eevee&oq=%D1%80%D0%B5%D0%BD%D0%B4%D0%B5%D1%80%D0%B8%D0%BD%D0%B3+%D0%B2+%D1%8C%D0%BB%D0%B5%D0%BD%D0%B4%D0%B5%D1%80+%D1%8D%D1%82%D0%BE&gs_lcrp=EgZjaHJvbWUyBggAEEUYOTIJCAEQABgNGIAEMgoIAhAAGIAEGKIEMgoIAxAAGIAEGKIE0gEJNzUzM2owajE1qAIIsAIB8QU3ak5NDMGz2PEFN2pOTQzBs9g&sourceid=chrome&ie=UTF-8&ved=2ahUKEwj01PuP8OyTAxUkKRAIHaIDAawQgK4QegYIAQgAEAQ
https://www.google.com/search?q=Workbench&oq=%D1%80%D0%B5%D0%BD%D0%B4%D0%B5%D1%80%D0%B8%D0%BD%D0%B3+%D0%B2+%D1%8C%D0%BB%D0%B5%D0%BD%D0%B4%D0%B5%D1%80+%D1%8D%D1%82%D0%BE&gs_lcrp=EgZjaHJvbWUyBggAEEUYOTIJCAEQABgNGIAEMgoIAhAAGIAEGKIEMgoIAxAAGIAEGKIE0gEJNzUzM2owajE1qAIIsAIB8QU3ak5NDMGz2PEFN2pOTQzBs9g&sourceid=chrome&ie=UTF-8&ved=2ahUKEwj01PuP8OyTAxUkKRAIHaIDAawQgK4QegYIAQgAEAU
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2. Скульптинг  – 

метод 3D-моделирования, имитирующий традиционную лепку из глины, при 

котором художник использует специальные кисти для изменения 

высокополигональной сетки объекта. Он позволяет создавать детализированных 

персонажей, органические объекты и текстуры, «вытягивая» или «продавливая» 

форму, в отличие от технического полигонального моделирования. 

Инструменты цифрового скульптинга дают необходимую мощность и гибкость для 

различных этапов процесса создания цифрового контента. 

 

3. Моделирование  – 

процесс создания трехмерных объектов (персонажей, окружения, техники) в 

бесплатном пакете с открытым кодом, использующий методы полигонального, 

скульптурного и процедурного моделирования 

Скульптинг, ретопология, моделирование, кривые — набор инструментов Blender для 

моделирования очень обширен и гибок. 
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4. Анимация и риггинг  – 

процесс подготовки 3D-модели к движению и ее последующее оживление. Риггинг 

создает «скелет» (арматуру) и управляющие элементы (риг) для деформации сетки, 

а анимация использует этот риг для создания движений во времени.  

Blender создан для анимации и используется при производстве награждённых 

короткометражных и полнометражных фильмов. 
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2. Создание сцены и объектов 

Чтобы понять, как создавать сцену и объекты с нуля, необходимо начать с чистого 

рабочего поля. При запуске программы в рабочей области уже находится куб — удалите 

его с помощью быстрой клавиши X. В рабочем пространстве останутся только оси без 

лишних элементов. Теперь попробуем создать объект и сцену самостоятельно. 

 

Поэтапное создание: 

 

Объект.  В качестве примера создадим куб и дадим ему форму. Для этого нажмите 

кнопки Add → Mesh → Cube. Затем изменим масштаб куба. Нажмите клавишу S, затем Z 

для уменьшения объёма, далее кликните правой кнопкой мыши для закрепления 

результата. 

 

Теперь сделаем объект с включением дополнительных элементов. Для этого перейдите в 

режим редактирования (Edit Mode) в верхней панели либо нажмите клавишу Tab. Этот 

режим нужен для изменения формы объекта с помощью изменения его граней, рёбер, 

вершины. 
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Добавьте новую вершину с помощью комбинации Ctrl + R. На объекте отобразится разрез 

— выберите место нового ребра. Затем «раздвойте» первый разрез с помощью сочетания 

клавиш Ctrl + B. Потяните мышью и подтвердите действие левой кнопкой. Аналогичным 

образом добавьте вертикальные разрезы с помощью клавиш Ctrl + R. 
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Работа с целым объектом закончилась. Перейдём к работе с отдельными частями объекта. 

Это может понадобиться, если к объекту нужно добавить части тела, кнопки и другие 

элементы. В Blender 3D части объекта выделяются с помощью числовых клавиш: 

 

1—вершины; 

2—рёбра; 

3—грани. 

 

Посмотрим, как редактирование с помощью клавиш выглядит на деле. Снова зайдите в 

режим редактирования. Нажмите сочетание Shift + 3 и выделите грани. Теперь нужно 

экструдировать грань перпендикулярно плоскости. Для этого нажмите клавишу E. 

Повторите шаги с клавишами 2 и 3. Вот что получилось: 

 

Сцена. Аналогичным образом можно создать сцену. Для этого удалите все объекты с 

экрана. Затем нажмите клавиши Shift + A → Mesh → Plane. На экране появится плоскость, 

далее нажмите S, затем тяните кнопкой мыши для масштабирования. После этого на сцену 

можно добавлять объекты, как описано выше. 
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3. Рендеринг анимации и установка ключевых кадров 

Анимация в Blender строится на установке ключевых кадров (клавиша I) для фиксации 

положения/свойств объекта на таймлайне (Timeline) и интерполяции между ними. 

Рендеринг анимации выполняется через Render -> Render Animation (Ctrl+F12) с 

предварительной настройкой формата файла, папки сохранения и частоты кадров (FPS) во 

вкладке Output Properties. 

 

1. Установка ключевых кадров (Keyframes) 

 

Основа: Выберите объект, перейдите на нужный кадр (Timeline), переместите/поверните 

объект и нажмите I, чтобы вставить ключ (позиция, вращение или масштаб). 

Авто-ключи (Auto-Keying): Включите круглую кнопку записи на таймлайне, чтобы 

Blender автоматически создавал ключи при любом изменении объекта. 

Вставка отдельных свойств: Нажмите правой кнопкой мыши (ПКМ) на поле свойства 

(например, цвет материала) -> «Insert Keyframe». 

Редактирование: Для управления интерполяцией (плавностью движения) используйте 

редактор Graph Editor, а для изменения времени ключей — Dope Sheet 

 

 

2. Рендеринг анимации (Rendering) 

 

Подготовка: Выберите движок (Cycles для фотореализма, Eevee для скорости) во 

вкладке Render Properties. 

Настройки вывода (Output): 

Перейдите в Output Properties. 
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Укажите папку сохранения, выберите формат файла (например, FFmpeg Video для видео 

или PNG последовательность). 

Установите Frame Range (диапазон кадров) и Frame Rate (FPS, обычно 24 или 30). 

Запуск: В верхнем меню выберите Render -> Render Animation или нажмите Ctrl+F12.  

Медиа Contented +1 

Совет: Рендерите анимацию в формат последовательности изображений (PNG/EXR), 

чтобы избежать потери данных при сбое, а затем скомпонуйте их в Blender Video Editor.  

Skyeng 
 

Когда создали объект, можно зафиксировать его движение. В нижней части рабочего 

пространства находится панель с дорожкой, на ней будут отмечаться точки (ключевые 

кадры) каждый раз, когда движение объекта будет фиксироваться левой кнопкой мыши. 

Чтобы начать запись, нажмите кружок в центре. 

 

Для движения объекта нужно нажать на него, затем на клавишу S и перемещать объект по 

сцене. Перемещения из точки А в точку В фиксируйте нажатием кнопки мыши. Чтобы 

посмотреть результат, верните голубой курсор к началу и нажмите Play (треугольник). 
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4. Добавление эффектов и переходов 

Когда движения записались, можно добавить переходы — это звуковые, видео- или 

анимированные эффекты. Мы расскажем про три эффекта. 

 

1. Анимация громкости (Sound Crossfade) 

Анимация громкости двух перекрывающихся звуковых полос. 

В Blender анимация громкости выполняется через установку ключевых кадров 

(keyframes) для параметра Volume в видеоредакторе (Video Sequencer) или настройках 

объекта-динамика (Speaker). 

1. Ручная анимация в Video Sequencer 

Этот способ подходит для видеомонтажа или простой настройки громкости фоновой 

музыки.  

O'Reilly books +1 

 Добавьте звук: Переключите тип рабочего пространства на Video Sequencer и добавьте 

аудиофайл (Shift+A -> Sound). 

 Создайте ключевой кадр: 

 Выделите звуковую дорожку. 

 В панели свойств (справа, клавиша N) найдите вкладку Sound и параметр Volume. 

 Установите ползунок времени на нужный кадр. 

 Наведите курсор на значение громкости и нажмите клавишу I — значение подсветится 

желтым, что означает создание ключевого кадра. 

 Измените громкость: Перейдите на другой кадр, измените значение громкости и снова 

нажмите I. Между кадрами Blender создаст плавный переход.  

docs.blender.org +1 

2. Запекание звука в F-кривые (Bake Sound to F-Curves) 

Используется, когда нужно, чтобы объект «пульсировал» или двигался в такт музыке. 

1. Выберите объект и параметр, который хотите анимировать (например, масштаб Scale). 

2. Добавьте любой ключ: Нажмите I на параметре Scale в окне свойств (Object Properties). 

3. Откройте Graph Editor: Перейдите в редактор графиков. 

4. Запеките звук: 

 В меню выберите Key -> Bake Sound to F-Curves. 

 Выберите ваш аудиофайл. 

 В настройках слева можно указать диапазон частот (например, только бас для низких 

пульсаций). 

5. Результат: Параметр объекта будет автоматически меняться в зависимости от амплитуды 

звука.  

Reddit 

3. Использование объекта Speaker (Динамик) 

Если вы создаете 3D-сцену, где звук должен исходить из конкретной точки 

(пространственное аудио): 

 Добавьте объект через Shift+A -> Speaker. 

 В настройках динамика (иконка мегафона) выберите аудиофайл. 
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 Параметр Volume здесь также можно анимировать клавишей I для создания эффекта 

затухания или усиления звука в 3D-пространстве.  

Reddit 

Важный нюанс при рендере: 

Чтобы звук попал в финальное видео, в настройках вывода (Output Properties) в 

разделе Encoding обязательно выберите Audio Codec (например, AAC или MP3), иначе 

видео будет беззвучным.  

 

 

 
 

2. Эффект наложения кадров (Gamma Cross)  

Проявление одной картинки из другой. Создаёт эффект наложения кадров, когда из 

первого кадра постепенно появляется другой, который полностью замещает экран. 

Для создания эффекта наложения кадров (ghosting/echo) в Blender, создающего шлейф за 

движущимся объектом, лучше всего использовать Geometry Nodes с симуляцией 

(Simulation Zone) для клонирования кадров или модификатор Time Offset. В 

компоновщике (Compositor) используется нода Alpha Over или режим 

смешивания Mix для наложения слоев.  

Reddit +1 

Основные способы создания эффекта: 

 Geometry Nodes (Simulation Zone): 

1. Создайте Geometry Nodes на объекте. 

2. Добавьте Simulation Zone. 

https://www.google.com/search?q=Geometry+Nodes&sca_esv=b4a9fe7ec4bea108&biw=1920&bih=953&ei=uRLeaZ7JM6jzwPAP08_zsAY&ved=2ahUKEwjC89jLje2TAxUTLRAIHWxqG1oQgK4QegQIARAC&uact=5&oq=%D0%B1%D0%BB%D0%B5%D0%BD%D0%B4%D0%B5%D1%80+%D1%8D%D1%84%D1%84%D0%B5%D0%BA%D1%82+%D0%BD%D0%B0%D0%BB%D0%BE%D0%B6%D0%B5%D0%BD%D0%B8%D1%8F+%D0%BA%D0%B0%D0%B4%D1%80%D0%BE%D0%B2&gs_lp=Egxnd3Mtd2l6LXNlcnAiO9Cx0LvQtdC90LTQtdGAINGN0YTRhNC10LrRgiDQvdCw0LvQvtC20LXQvdC40Y8g0LrQsNC00YDQvtCyMgUQIRigATIFECEYoAFItRBQ9wpY1g1wAXgAkAEAmAFyoAGZAqoBAzIuMbgBA8gBAPgBAfgBApgCBKACqQLCAggQABiwAxjvBcICCxAAGIAEGLADGKIEwgIFEAAYgATCAggQABiABBixA5gDAIgGAZAGBJIHAzMuMaAHkxKyBwMyLjG4B6UCwgcFMC4yLjLIBwuACAA&sclient=gws-wiz-serp
https://www.google.com/search?q=%D0%BC%D0%BE%D0%B4%D0%B8%D1%84%D0%B8%D0%BA%D0%B0%D1%82%D0%BE%D1%80+Time+Offset&sca_esv=b4a9fe7ec4bea108&biw=1920&bih=953&ei=uRLeaZ7JM6jzwPAP08_zsAY&ved=2ahUKEwjC89jLje2TAxUTLRAIHWxqG1oQgK4QegQIARAD&uact=5&oq=%D0%B1%D0%BB%D0%B5%D0%BD%D0%B4%D0%B5%D1%80+%D1%8D%D1%84%D1%84%D0%B5%D0%BA%D1%82+%D0%BD%D0%B0%D0%BB%D0%BE%D0%B6%D0%B5%D0%BD%D0%B8%D1%8F+%D0%BA%D0%B0%D0%B4%D1%80%D0%BE%D0%B2&gs_lp=Egxnd3Mtd2l6LXNlcnAiO9Cx0LvQtdC90LTQtdGAINGN0YTRhNC10LrRgiDQvdCw0LvQvtC20LXQvdC40Y8g0LrQsNC00YDQvtCyMgUQIRigATIFECEYoAFItRBQ9wpY1g1wAXgAkAEAmAFyoAGZAqoBAzIuMbgBA8gBAPgBAfgBApgCBKACqQLCAggQABiwAxjvBcICCxAAGIAEGLADGKIEwgIFEAAYgATCAggQABiABBixA5gDAIgGAZAGBJIHAzMuMaAHkxKyBwMyLjG4B6UCwgcFMC4yLjLIBwuACAA&sclient=gws-wiz-serp
https://www.google.com/search?q=Alpha+Over&sca_esv=b4a9fe7ec4bea108&biw=1920&bih=953&ei=uRLeaZ7JM6jzwPAP08_zsAY&ved=2ahUKEwjC89jLje2TAxUTLRAIHWxqG1oQgK4QegQIARAE&uact=5&oq=%D0%B1%D0%BB%D0%B5%D0%BD%D0%B4%D0%B5%D1%80+%D1%8D%D1%84%D1%84%D0%B5%D0%BA%D1%82+%D0%BD%D0%B0%D0%BB%D0%BE%D0%B6%D0%B5%D0%BD%D0%B8%D1%8F+%D0%BA%D0%B0%D0%B4%D1%80%D0%BE%D0%B2&gs_lp=Egxnd3Mtd2l6LXNlcnAiO9Cx0LvQtdC90LTQtdGAINGN0YTRhNC10LrRgiDQvdCw0LvQvtC20LXQvdC40Y8g0LrQsNC00YDQvtCyMgUQIRigATIFECEYoAFItRBQ9wpY1g1wAXgAkAEAmAFyoAGZAqoBAzIuMbgBA8gBAPgBAfgBApgCBKACqQLCAggQABiwAxjvBcICCxAAGIAEGLADGKIEwgIFEAAYgATCAggQABiABBixA5gDAIgGAZAGBJIHAzMuMaAHkxKyBwMyLjG4B6UCwgcFMC4yLjLIBwuACAA&sclient=gws-wiz-serp
https://www.google.com/search?q=Mix&sca_esv=b4a9fe7ec4bea108&biw=1920&bih=953&ei=uRLeaZ7JM6jzwPAP08_zsAY&ved=2ahUKEwjC89jLje2TAxUTLRAIHWxqG1oQgK4QegQIARAF&uact=5&oq=%D0%B1%D0%BB%D0%B5%D0%BD%D0%B4%D0%B5%D1%80+%D1%8D%D1%84%D1%84%D0%B5%D0%BA%D1%82+%D0%BD%D0%B0%D0%BB%D0%BE%D0%B6%D0%B5%D0%BD%D0%B8%D1%8F+%D0%BA%D0%B0%D0%B4%D1%80%D0%BE%D0%B2&gs_lp=Egxnd3Mtd2l6LXNlcnAiO9Cx0LvQtdC90LTQtdGAINGN0YTRhNC10LrRgiDQvdCw0LvQvtC20LXQvdC40Y8g0LrQsNC00YDQvtCyMgUQIRigATIFECEYoAFItRBQ9wpY1g1wAXgAkAEAmAFyoAGZAqoBAzIuMbgBA8gBAPgBAfgBApgCBKACqQLCAggQABiwAxjvBcICCxAAGIAEGLADGKIEwgIFEAAYgATCAggQABiABBixA5gDAIgGAZAGBJIHAzMuMaAHkxKyBwMyLjG4B6UCwgcFMC4yLjLIBwuACAA&sclient=gws-wiz-serp
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3. Используйте Join Geometry внутри зоны, объединяя текущий кадр (Object Info -

> Geometry) с предыдущими (через симуляцию). 

4. Для затухания добавьте ноду Delete Geometry по времени жизни. 

 Time Offset Modifier: 

1. Дублируйте объект несколько раз (Shift+D). 

2. Добавьте модификатор Time Offset к дубликатам. 

3. Установите отрицательные значения кадров (например, -1, -2, -3), чтобы каждый дубликат 

показывал предыдущее состояние анимации. 

 Композитинг (Compositor): 

1. Отрендерите анимацию с прозрачным фоном. 

2. В композиторе используйте ноды Movie Clip и Mix (режим Lighten или Screen) для 

наложения кадров друг на друга.  

 

 

 

 

3. Замедление (Slowing down) 

 Замедление самый простой способ — передвижение объектов меток по дорожке. Это 

нужно, чтобы движения объекта не были слишком резкими. Для плавного перехода 

отодвиньте ключевые кадры подальше друг от друга. 

В Blender существует несколько способов замедлить картинку или анимацию, в 

зависимости от того, работаете ли вы с 3D-анимацией или видеоредактором (VSE). 

Вот основные методы: 

1. Замедление видео в Видеоредакторе (Video Sequence Editor) 

Если у вас есть видеофайл и вы хотите его замедлить: 

1. Откройте рабочее пространство Video Editing. 

2. Добавьте видеофайл (Add -> Movie). 

3. Выберите полосу видео, нажмите Add -> Effect Strip -> Speed Control (Управление 

скоростью). 

https://www.google.com/search?q=%D0%9A%D0%BE%D0%BC%D0%BF%D0%BE%D0%B7%D0%B8%D1%82%D0%B8%D0%BD%D0%B3&sca_esv=b4a9fe7ec4bea108&biw=1920&bih=953&ei=uRLeaZ7JM6jzwPAP08_zsAY&ved=2ahUKEwjC89jLje2TAxUTLRAIHWxqG1oQgK4QegQIAxAK&uact=5&oq=%D0%B1%D0%BB%D0%B5%D0%BD%D0%B4%D0%B5%D1%80+%D1%8D%D1%84%D1%84%D0%B5%D0%BA%D1%82+%D0%BD%D0%B0%D0%BB%D0%BE%D0%B6%D0%B5%D0%BD%D0%B8%D1%8F+%D0%BA%D0%B0%D0%B4%D1%80%D0%BE%D0%B2&gs_lp=Egxnd3Mtd2l6LXNlcnAiO9Cx0LvQtdC90LTQtdGAINGN0YTRhNC10LrRgiDQvdCw0LvQvtC20LXQvdC40Y8g0LrQsNC00YDQvtCyMgUQIRigATIFECEYoAFItRBQ9wpY1g1wAXgAkAEAmAFyoAGZAqoBAzIuMbgBA8gBAPgBAfgBApgCBKACqQLCAggQABiwAxjvBcICCxAAGIAEGLADGKIEwgIFEAAYgATCAggQABiABBixA5gDAIgGAZAGBJIHAzMuMaAHkxKyBwMyLjG4B6UCwgcFMC4yLjLIBwuACAA&sclient=gws-wiz-serp
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4. В настройках полосы Speed Control снимите галочку Stretch to input strip length, если она 

есть. 

5. Включите Multiply Speed (Множитель скорости) и установите значение меньше 1.0 

(например, 0.5 для замедления в 2 раза).  

docs.blender.org +1 

2. Замедление 3D-анимации (Keyframes) 

Если вы хотите замедлить движение 3D-объектов: 

1. Перейдите в Dope Sheet или Timeline. 

2. Выделите все ключевые кадры (нажмите A). 

3. Нажмите клавишу S (Scale), затем введите число, чтобы растянуть кадры (например, S 

2 растянет анимацию в два раза, сделав её медленнее).  

Reddit 

3. Замедление через настройку Frame Rate (FPS) 

Этот способ меняет скорость рендера: 

 В настройках рендера измените частоту кадров (Frame Rate) на более низкую (например, с 

60 до 30), при этом анимация станет длиннее и медленнее.  

Reddit 

4. Изменение времени (Time Remapping) 

В настройках Output Properties -> Time Remapping: 

 Увеличьте значение Old по сравнению с New. Например, если установить Old: 200 и New: 

100, время замедлится в 2 раза.  

docs.blender.org 

Совет: Для плавного замедления (slow-mo) видео убедитесь, что в настройках полосы 

скорости включена функция интерполяции кадров, чтобы не было "дерганья". 
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4. Экспорт и публикация  

Blender 3D поддерживает практически все популярные форматы файлов. Например, 

можно экспортировать объекты в формате ABC, USD, OBJ, FBX, PLY, STL. Для экспорта 

в левом верхнем углу нажмите File → Export и выберите формат файла и путь для его 

сохранения. 

 

 

Основные форматы экспорта 

 FBX (.fbx): Стандарт для игровых движков (Unity, Unreal) и анимации. 

 GLTF/GLB (.glb/.gltf): Идеально для веб-ар, VR и AR, так как поддерживает материалы и 

текстуры. 

 OBJ (.obj): Простой формат для статических моделей. 

 STL (.stl): Для 3D-печати.  

VR Concept +4 

Пошаговый экспорт (на примере FBX/GLTF) 

1. Откройте меню File > Export. 

2. Выберите нужный формат (например, FBX или glTF 2.0). 

3. В окне настроек: 

1. Включение текстур: В FBX укажите Path Mode: Copy и нажмите кнопку встроенных 

файлов (иконка папки) рядом. 

2. Ограничение экспорта: Поставьте галочку «Selected Objects» (Выделенные объекты), 

чтобы экспортировать только нужное. 

3. Анимация: Убедитесь, что галочка «Baked Animation» включена. 

https://practicum.yandex.ru/blog/kak-delat-animaciyu-v-blender/#rendering-animatsii-i-ustanovka-klyuchevykh-kadrov
https://practicum.yandex.ru/blog/kak-delat-animaciyu-v-blender/#rendering-animatsii-i-ustanovka-klyuchevykh-kadrov
https://practicum.yandex.ru/blog/kak-delat-animaciyu-v-blender/#dobavleniye-effektov-i-perekhodov
https://practicum.yandex.ru/blog/kak-delat-animaciyu-v-blender/#dobavleniye-effektov-i-perekhodov
https://practicum.yandex.ru/blog/kak-delat-animaciyu-v-blender/#rendering-animatsii-i-ustanovka-klyuchevykh-kadrov
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4. Нажмите Export.  

VR Concept +2 

Подготовка к публикации 

 Применение трансформаций: Перед экспортом выделите объект и нажмите Ctrl + A -> 

«Apply All Transforms» (Scale, Rotation, Location), чтобы модель не исказилась в другом 

ПО. 

 Очистка: Удалите неиспользуемые объекты и объедините меши (Join), если нужно. 

 Материалы: Проверьте текстуры и материалы, убедитесь, что они корректно запечены или 

экспортируются вместе с моделью.  

Reddit +2 

Платформы для публикации 

 Sketchfab: Лучший сайт для просмотра и продажи 3D-моделей в браузере. 

 Unity/Unreal Engine: Импорт через drag-and-drop с последующей настройкой материалов. 

 CGTrader / TurboSquid: Маркетплейсы для продажи моделей. 

 

 

Список литературы  

для изучения 3D-моделирования в Blender включает фундаментальные руководства от 

BHV-Петербург (А. Прахов), официальную документацию и специализированные 

форумы. Основные ресурсы фокусируются на моделировании, анимации и рендеринге в 

версиях 2.8+.  

Рекомендуемая литература: 

 Прахов А. А. «Blender: 3D-моделирование и анимация. Руководство для начинающих» — 

актуальное учебное пособие. 

 Прахов А. А. «Самоучитель Blender 2.7» — несмотря на версию, полезен для понимания 

основ. 

 Официальное руководство Blender (Blender Manual) — самый актуальный источник, 

доступен онлайн. 

 «Blender. Настольная книга» (blender-handbook) — статьи от простого к сложному.  

MOODLE КНИТУ (КХТИ) +3 

Онлайн-ресурсы и сообщества: 

 Официальный сайт blender.org — скачивание программы и документация. 

 Форумы (например, gcup.ru) — обсуждение уроков и версий. 

.  

https://www.google.com/search?q=Sketchfab&oq=%D0%B1%D0%BB%D0%B5%D0%BD%D0%B4%D0%B5%D1%80%09%D0%AD%D0%BA%D1%81%D0%BF%D0%BE%D1%80%D1%82+%D0%B8+%D0%BF%D1%83%D0%B1%D0%BB%D0%B8%D0%BA%D0%B0%D1%86%D0%B8%D1%8F+&gs_lcrp=EgZjaHJvbWUyBggAEEUYOTIHCAEQIRigATIHCAIQIRigATIHCAMQIRigATIHCAQQIRigAdIBCTcxMDFqMGoxNagCCLACAfEFstMxDoPAzjzxBbLTMQ6DwM48&sourceid=chrome&ie=UTF-8&mstk=AUtExfAceiRksI6mSuwwiXKW-XryZMSEjEkYFAcb2-9lR0QYlsEVK8KJXiBQGk3oPb7y2dR4HJUh-otABtG6vg8XQmX2sSIL4Gk1ffqv3sELBGGV_JverCWTBfQ9otogZn_udWA&csui=3&ved=2ahUKEwizlsjsj-2TAxUWFBAIHUPnNQ0QgK4QegQIChAB
https://www.google.com/search?q=CGTrader&oq=%D0%B1%D0%BB%D0%B5%D0%BD%D0%B4%D0%B5%D1%80%09%D0%AD%D0%BA%D1%81%D0%BF%D0%BE%D1%80%D1%82+%D0%B8+%D0%BF%D1%83%D0%B1%D0%BB%D0%B8%D0%BA%D0%B0%D1%86%D0%B8%D1%8F+&gs_lcrp=EgZjaHJvbWUyBggAEEUYOTIHCAEQIRigATIHCAIQIRigATIHCAMQIRigATIHCAQQIRigAdIBCTcxMDFqMGoxNagCCLACAfEFstMxDoPAzjzxBbLTMQ6DwM48&sourceid=chrome&ie=UTF-8&mstk=AUtExfAceiRksI6mSuwwiXKW-XryZMSEjEkYFAcb2-9lR0QYlsEVK8KJXiBQGk3oPb7y2dR4HJUh-otABtG6vg8XQmX2sSIL4Gk1ffqv3sELBGGV_JverCWTBfQ9otogZn_udWA&csui=3&ved=2ahUKEwizlsjsj-2TAxUWFBAIHUPnNQ0QgK4QegQIChAE
https://www.google.com/search?q=TurboSquid&oq=%D0%B1%D0%BB%D0%B5%D0%BD%D0%B4%D0%B5%D1%80%09%D0%AD%D0%BA%D1%81%D0%BF%D0%BE%D1%80%D1%82+%D0%B8+%D0%BF%D1%83%D0%B1%D0%BB%D0%B8%D0%BA%D0%B0%D1%86%D0%B8%D1%8F+&gs_lcrp=EgZjaHJvbWUyBggAEEUYOTIHCAEQIRigATIHCAIQIRigATIHCAMQIRigATIHCAQQIRigAdIBCTcxMDFqMGoxNagCCLACAfEFstMxDoPAzjzxBbLTMQ6DwM48&sourceid=chrome&ie=UTF-8&mstk=AUtExfAceiRksI6mSuwwiXKW-XryZMSEjEkYFAcb2-9lR0QYlsEVK8KJXiBQGk3oPb7y2dR4HJUh-otABtG6vg8XQmX2sSIL4Gk1ffqv3sELBGGV_JverCWTBfQ9otogZn_udWA&csui=3&ved=2ahUKEwizlsjsj-2TAxUWFBAIHUPnNQ0QgK4QegQIChAF
https://www.google.com/search?q=%D0%9F%D1%80%D0%B0%D1%85%D0%BE%D0%B2+%D0%90.+%D0%90.+%C2%ABBlender%3A+3D-%D0%BC%D0%BE%D0%B4%D0%B5%D0%BB%D0%B8%D1%80%D0%BE%D0%B2%D0%B0%D0%BD%D0%B8%D0%B5+%D0%B8+%D0%B0%D0%BD%D0%B8%D0%BC%D0%B0%D1%86%D0%B8%D1%8F.+%D0%A0%D1%83%D0%BA%D0%BE%D0%B2%D0%BE%D0%B4%D1%81%D1%82%D0%B2%D0%BE+%D0%B4%D0%BB%D1%8F+%D0%BD%D0%B0%D1%87%D0%B8%D0%BD%D0%B0%D1%8E%D1%89%D0%B8%D1%85%C2%BB&sca_esv=829b6725c1213f11&ei=oRXeaaiBFsPLwPAPkYnb0AI&biw=1920&bih=953&ved=2ahUKEwjRhKaLkO2TAxVLKRAIHSxuHCoQgK4QegQIAxAB&uact=5&oq=%D0%B1%D0%BB%D0%B5%D0%BD%D0%B4%D0%B5%D1%80+%D1%81%D0%BF%D0%B8%D1%81%D0%BE%D0%BA+%D0%BB%D0%B8%D1%82%D0%B5%D1%80%D0%B0%D1%82%D1%83%D1%80%D1%8B&gs_lp=Egxnd3Mtd2l6LXNlcnAiMNCx0LvQtdC90LTQtdGAINGB0L_QuNGB0L7QuiDQu9C40YLQtdGA0LDRgtGD0YDRizIFECEYoAFI1CZQrQdY9CNwAXgBkAEAmAFmoAHmC6oBBDE1LjK4AQPIAQD4AQGYAhKgAp8MwgIKEAAYsAMY1gQYR8ICCBAAGIAEGLEDwgIFEAAYgATCAggQABgWGAoYHsICBhAAGBYYHsICBRAAGO8FwgIFECEYnwXCAgcQIRigARgKmAMAiAYBkAYIkgcEMTYuMqAHjFSyBwQxNS4yuAeYDMIHBjEuMTUuMsgHI4AIAA&sclient=gws-wiz-serp&mstk=AUtExfC1iQw6SG0cdPYdDPhseXm1hh3GLhKpD56gUvOmN5Jltr_Vc_W5Ki77rFd4oM5QWhGvqwAnS9kam5ssgRzwsBe-Vm4f2wdaEJuyG6sWf8To4SYPEl1PcuPlB3l6L2H2I2k&csui=3
https://www.google.com/search?q=%D0%9F%D1%80%D0%B0%D1%85%D0%BE%D0%B2+%D0%90.+%D0%90.+%C2%AB%D0%A1%D0%B0%D0%BC%D0%BE%D1%83%D1%87%D0%B8%D1%82%D0%B5%D0%BB%D1%8C+Blender+2.7%C2%BB&sca_esv=829b6725c1213f11&ei=oRXeaaiBFsPLwPAPkYnb0AI&biw=1920&bih=953&ved=2ahUKEwjRhKaLkO2TAxVLKRAIHSxuHCoQgK4QegQIAxAD&uact=5&oq=%D0%B1%D0%BB%D0%B5%D0%BD%D0%B4%D0%B5%D1%80+%D1%81%D0%BF%D0%B8%D1%81%D0%BE%D0%BA+%D0%BB%D0%B8%D1%82%D0%B5%D1%80%D0%B0%D1%82%D1%83%D1%80%D1%8B&gs_lp=Egxnd3Mtd2l6LXNlcnAiMNCx0LvQtdC90LTQtdGAINGB0L_QuNGB0L7QuiDQu9C40YLQtdGA0LDRgtGD0YDRizIFECEYoAFI1CZQrQdY9CNwAXgBkAEAmAFmoAHmC6oBBDE1LjK4AQPIAQD4AQGYAhKgAp8MwgIKEAAYsAMY1gQYR8ICCBAAGIAEGLEDwgIFEAAYgATCAggQABgWGAoYHsICBhAAGBYYHsICBRAAGO8FwgIFECEYnwXCAgcQIRigARgKmAMAiAYBkAYIkgcEMTYuMqAHjFSyBwQxNS4yuAeYDMIHBjEuMTUuMsgHI4AIAA&sclient=gws-wiz-serp&mstk=AUtExfC1iQw6SG0cdPYdDPhseXm1hh3GLhKpD56gUvOmN5Jltr_Vc_W5Ki77rFd4oM5QWhGvqwAnS9kam5ssgRzwsBe-Vm4f2wdaEJuyG6sWf8To4SYPEl1PcuPlB3l6L2H2I2k&csui=3
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